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Legal Notices 

Warranty 

The only warranties for HP products and services are set forth in the express warranty statements 
accompanying such products and services. Nothing herein should be construed as constituting an additional 
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Restricted Rights Legend 

Confidential computer software. Valid license from HP required for possession, use or copying. Consistent 
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Technical Data for Commercial Items are licensed to the U.S. Government under vendor's standard 
commercial license. 

Copyright Notices 

© Copyright 1993-2006 Hewlett-Packard Development Company, L.P. 
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Support 

Peregrine Product Support 

You can obtain support information for products formerly produced by Peregrine as follows: 

• If you work with an HP OpenView Services Integrator (SVI) partner 
(www.hp.com/managementsoftware/svi_partner_list), contact your SVI agent. 

• If you have an active HP OpenView support contract, visit the HP OpenView Support site and use the 
Self-Solve Knowledge Search to find answers to technical questions. 

• For the latest information about support processes and tools available for products formerly produced by 
Peregrine, we encourage you to visit the HP-Peregrine Software Support web site at: 
www.hp.com/managementsoftware/peregrine_support 
where you can download the Customer Support Handbook. 

• Contact your HP Sales Representative if you have additional questions. 

HP OpenView Support 

You can visit the HP OpenView Support web site at: 

www.hp.com/managementsoftware/support

HP OpenView online support provides an efficient way to access interactive technical support tools. As a 
valued support customer, you can benefit by using the support site to: 

• Search for knowledge documents of interest 

• Submit and track support cases and enhancement requests 

• Download software patches 

• Manage support contracts 

• Look up HP support contacts 

• Review information about available services 

• Enter into discussions with other software customers 

• Research and register for software training 

Most of the support areas require that you register as an HP Passport user and sign in. Many also require a 
support contract.   

To find more information about access levels, go to:  
www.hp.com/managementsoftware/access_level

To register for an HP Passport ID, go to: 
www.managementsoftware.hp.com/passport-registration.html
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HP OpenView Enterprise Discovery 

Release Notes 
Software version: 2.1.1 / October 2006 

This document provides an overview of the changes made to Enterprise Discovery for version 2.1.1. It 
contains important information not included in the manuals or in online help. 

In This Version

Documentation Updates

Installation Notes

Enhancements and Fixes

Known Problems, Limitations, and Workarounds
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In This Version 

Introduction 

These release notes are for Enterprise Discovery 2.1.1. This new version of Enterprise Discovery is the 
upgrade path for users of Enterprise Discovery 2.1, 2.0.x, and users of Network Discovery 5.2.5.  

If you want to see what features have been introduced in Enterprise Discovery 2.0, 2.0.1, 2.0.2, 2.0.3, and 
2.1, you can read the Release Notes for those versions, available on your installation CD under 
bin\documentation.  

License Schema 

Each Enterprise Discovery server can collect data for a maximum of 50,000 devices or 100,000 ports 
(whichever comes first). An Enterprise Discovery Aggregator can support 50 servers and up to 500,000 
devices.   

Updated third party components 

• Apache httpd 2.0.59 

• JRE 1.4.2_12 

• MySQL 4.1.21 

• OpenSSL 0.9.7l 

• OpenSSL 0.9.8d 

New Features  

There are some minor new features added to this version of Enterprise Discovery.  

Extended Find 

New options have been added to the Find feature so that you can search based on Asset Data fields. The 
Find criteria menu has been rearranged and now includes two levels of specification. 

MIB Browser Improvements 

The MIB Browser is always available, regardless of license. You can now view, create, and copy user 
credentials in the MIB Browser dialog that support SNMPv3 user credentials. 

Scanner Detection of Multi-Core CPUs 

Enterprise Discovery now supports multi-core processors for Windows® and Linux operating systems. When 
a server or workstation is discovered, both the physical number of CPUs and the number of processing cores 
in each CPU are recorded. 
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Improvements to Inventory Scanning Process (Workflow Changes) 

Scanner deployment workflow now removes a device from the “Pending Agent Deployment” queue when a 
manually initiated agent ping for the device is successful.  

Two XML Enrichers 

By default, Enterprise Discovery is configured to use one XML Enricher service. This is adequate for most 
situations. However, in exceptional circumstances when the scan files flow into the incoming directory faster 
than the XML Enricher is able to process them, a build-up of scan files can appear in the incoming directory. 
To allocate more processing power to enriching scan files, Enterprise Discovery can now be configured to use 
2 XML Enricher services. You can specify this in Administration > System Configuration > Server 
Configuration > Number of XML Enrichers to run. Additional CPUs may be required to use this feature. 

Navigation Tree Behavior 

Then navigation tree in the web UI behaves a bit differently. If you click an item with children, that item is 
selected, and its content is displayed on the right side of the UI. The branch under that item in the left 
navigation menu is not expanded, however. You must double-click the item to expand the branch 
underneath it. 

Improved Breadcrumb Behavior 

The breadcrumb behavior is now consistent. The breadcrumbs update properly no matter how you get to a 
specific page. In addition, the last link in the breadcrumb trail is now clickable. You can see this on pages 
where you enter and then save some data. For example, if you go to Administration > Account 
Administration > Add an account, and you try to add an account by clicking the Add account button, the 
“Add” breadcrumb on the new page that opens will be clickable. This enables you to go back to the Add page 
and add a new account. 

Daylight Savings Time Changes 

There is an upgrade in the JRE third party component to adapt to the new daylight savings time. Daylight 
savings time in the U.S. and Canada will begin earlier (the second Sunday in March) and end later (the first 
Sunday in November) starting in 2007. 

Disable Unused Accounts 

You can now specify the time after which unused accounts are disabled. Choices range from 30 days to 
Never. By default, accounts are no longer disabled upon upgrade. 

MKS Perl Warning 

If you attempt to install the Enterprise Discovery server on a system where MKS Perl is installed, you will 
receive a warning message indicating that the MKS Perl distribution is incompatible with Enterprise 
Discovery. 

Obsolete Features 

All features in 2.1 are currently supported in release 2.1.1. 

6 



Documentation Updates 
The first page of this release notes document contains the following identifying information: 

• Version number, which indicates the software version. 

• Publish date, which changes each time the document is updated. 

 

To check for recent updates or to verify that you are using the most recent edition, visit the following URL: 

http://ovweb.external.hp.com/lpe/doc_serv/ 

1 In the Product list, click the product name (for example, Enterprise Discovery). 

2 In the Version list, click the version number. 

3 In the OS list, click the operating system type. 

4 In the document list, click the document title. 

5 To retrieve the document, click Open or Download. 

 

 To view files in PDF format (*.pdf), Adobe® Acrobat® Reader must be installed on your 
system. To download the Adobe Acrobat Reader, go to the following URL: 

www.adobe.com

 

The following PDF documents are available in the Enterprise Discovery user interface: 

• Planning Guide  

• Installation and Initial Setup Guide 

• Configuration and Customization Guide 

• Network Data Analysis Guide 

• Scan Data Analysis Guide 

• Reference Guide 

• Network Discovery Migration Guide 

 

One other PDF file is available on the install CD at bin/documentation: 

• Legacy Scanners 

 

And this last document is available in HTML format, through the Enterprise Discovery client (Start > All 
Programs > HP OpenView > Enterprise Discovery 2.1.1 > Documentation) 

• Data Collected by the Scanner
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Installation Notes 
Installation requirements, as well as instructions for installing Enterprise Discovery, are documented in the 
Installation and Initial Setup Guide provided in Adobe Acrobat (.pdf) format.  

If you are upgrading from a previous version, you need to follow these steps: 

1 If you have created your own User SAIs, make sure you back them up manually before uninstalling 
Enterprise Discovery.   

2 Save an external backup of your data, if necessary.  

3 Uninstall the old version of Enterprise Discovery, using the Windows “Add/Remove Programs” feature.  

4 Depending on the version you are upgrading from, delete one of the following directories from the server:  
 
Version 2.0.x: C:\Program Files\Peregrine\Enterprise Discovery\*.* 
 
Version 2.1.0: C:\Program Files\HP OpenView\Enterprise Discovery\2.1.0 

5 Reboot the server before you install the new version.  

The uninstallation will not delete the Enterprise Discovery Data directory. Rebooting the server will 
ensure that all parts of Enterprise Discovery are removed. 

6 Install the new version and follow the steps in the Installation and Initial Setup Guide. 

If you changed the default location of the Data directory when you installed a previous version, you need 
to ensure that you use the same location when you install the new version.  

  

 
Perl, MySQL, Tomcat and Apache are standard parts of the Enterprise Discovery, included with 
each server installation. If you have these components installed already, make sure to remove 
them before installing Enterprise Discovery. You may NOT substitute any other technologies in 
place of the standard installation. 
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Software and Hardware Requirements 

The Enterprise Discovery server can be installed on Windows 2003 Server SP1. (Windows® XP SP2 is also 
compatible, but should only be used for trial or demo installations.) 

The following table details a variety of scenarios that can help you estimate your server hardware 
requirements. The Disk value is for your data directory. You will require at least 6MB under Program Files 
for the Enterprise Discovery installation.  

Table 1 - Hardware Requirements 

Devices Ports Aggregation Inventory Topology 
Memory 
(GB) CPU 

Disk 
(GB) 

5,000 30,000   x    1.5 
1 CPU 
2.4GHz 25 

5,000 30,000     x  1.5* 

1 CPU 
2.8 GHz 
hyperthreading 15 

5,000 30,000   x x  2* 

1 CPU 
2.8 GHz 
hyperthreading 35 

15,000 90,000   x    2 

2 CPUs 
3 GHz 
hyperthreading 70 

15,000 90,000     x  3.5 

2 CPUs 
3 GHz 
hyperthreading 35 

15,000 90,000   x x 4  

2 CPUs 
3 GHz 
hyperthreading 100 

50,000 100,000   x   3 

2 CPUs 
3.6 GHz 
hyperthreading 200 

50,000 100,000     x 4 

2 CPUs 
3.6 GHz 
hyperthreading 50 

50,000 100,000   x x 5 

2 CPUs 
3.6 GHz 
hyperthreading 240 

50,000 n/a x n/a n/a 2  

2 CPUs 
3 GHz 
hyperthreading 10 

500,000 n/a x n/a n/a  3 

2 CPUs 
3.6 GHz 
hyperthreading 50 

* This is for 5 map sessions. If you want to use more than 5 map sessions, you will require more memory 

 

 
These requirements are running one XML Enricher. If you plan to run two XML Enrichers, more 
CPUs may be required. 
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These calculations have been tested as scenarios for maximum disk size on the server. For the Inventory 
license, this includes: 

• Backup Scan Files in enabled (on average, each scan file is 250KB) 

• Generate MIF Files is enabled  

• Delta scanning is enabled 

• Space required for two backups (one stored backup, and one “in process” backup) 

• For the Network Topology license, this includes: 

• Statistic Export is enabled (CSV files) 

• 200 users, with each user account saving 10 map configurations files 

• Space required for two backups (one stored backup, and one “in process” backup) 

The Enterprise Discovery client has the following requirements: 

Operating System Windows 2000, XP, or 2003 

CPU Pentium® III, 500 MHz 

RAM 500 MB (1-3 GB if you will be analyzing a large number of scan files.) 

Disk 100MB required (2GB recommended) 

Java™ Runtime 
Environment 

1.4.2 or 1.5 
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Enhancements and Fixes 
The following items (identified by error tracking number) were added or fixed in the current software 
release. Table 2 lists enhancements to existing features or behavior; Table 3 lists problems that were fixed. 

Table 2 - Enhancements 

Number Location Enhancement Description 

16789 Administration > Remote 
server administration > 
Remote Server Properties 

The Aggregator transfer schedule is now allowed to 
be every hour. 

16428 Administration > System 
Configuration > Expiry 

The “Stale Connection Interval” setting was 
previously misnamed. 

16901 Agents On Windows NT® 4 workstations and Server 
where the Enterprise Discovery agent is running 
with the usage plug-in enabled, a large amount of 
network traffic occurs.  The plug-in was enhanced 
to eliminate the unnecessary traffic. 

16280 Backup/Restore In attempting to reduce the space and time 
requirements to produce the daily archive (backup) 
file, it is now possible to elect not to save the 
contents of the <DataDir>/Aggregate/Imported 
directory. 

15701 Database Changes to database schema and configuration 
files for discovery process. 

16290 Device Manager Device manager default window size is now larger. 

16710  Documentation Mac OS X agent installation is now documented. 

15914  Find Find no longer returns duplicate entries when 
searching by IP address. The port takes precedence 
if the search returns both device and port entries 
to avoid duplication. 

16344 Network Map The Network Map no longer disconnects 
automatically, especially if the server is very busy. 

16393 Network Map Correct file extension is now ensured when saving 
files with the chooser. 

16445, 16602, 16645 Notification The process of sending SNMP traps has been 
improved. The ability to set the location of the 
snmptrap software, as well as enhanced checks 
that the correct version of the software will be 
executed are now available. The snmptrap location 
can be configured by using Administration > SNMP 
Trap Configuration > Set software location. 
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Number Location Enhancement Description 

16401 Scanners Scanners can now properly detect dual core CPUs 
on Windows and UNIX systems. 

16443 Scanners When performing an upgrade, and deleting 
scanners from <data directory>\scanners, the 
scanners will now be automatically updated. 

16372  UNIX Scanners Support for new UNIX CPUs has now been added. 

16340  Web UI The splash screen has been improved. 

16353  Web UI The rendering of the navigation tree has been 
optimized. This is visible on aggregators with a 
large number of servers. 

16426  Web UI On large servers, some numbers on the home page 
will update less frequently to improve system 
performance. 

 

 

Table 3 – Problems Fixed 

Number Location Fix Description 

16706 Account administration It is no longer possible to create a user account 
without a password when a new user account is 
created in Server > Administration > Account 
Administration > Add an account. 

16212 Administration A “No ED server” warning no longer appears on 
the Home Page if the Enterprise Discovery server 
has a duplicate model in the database. 

16391 Administration An issue has been resolved regarding duplicated 
server names in the case where the Aggregator 
server is named “aggregator.” 

 

16628 Administration > Account 
Administration > Add an 
account 

The server error message encountered when trying 
to modify the account properties has been 
corrected. 

16662 Administration > Event 
filter configuration 

In the Event configuration page, if nothing is 
selected in check box group, it is now automatically 
set to all. 

16470, 16472 Administration > MySQL 
accounts 

If username and password are the same value, the 
account is created after the password is modified. 

16671 Administration > MySQL It is now possible to change Mysql Account 
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Number Location Fix Description 

accounts passwords. 

16370 Administration > Network 
Configuration 

Button in the network configuration add range is 
now grayed out if no group/set is selected. 

16750 Administration > Network 
Configuration > SNMP 
Property Group 

The SNMPv3 credentials are now validated. 

16665 Administration > Router 
Discovery > Router 
discovery results 

Router discovery results no longer return a server 
error. 

16660 Administration > System 
Configuration > Scan file 
management 

Hardware field names are now truncated to 
remove trailing spaces before verification. 

16469 Agents Mac OS X agent is now upgrading correctly in a 
consistent manner. 

16257 Aggregate agent status Clicking the CSV link on the Aggregate View > 
Status > Aggregate agent status page no longer 
causes the 404 error messages. 

16144 Aggregate Find Aggregate Find box no longer returns wrong data. 

15430 Aggregator Remote server properties are no longer reset to the 
default values after a system restart. 

16286 Aggregator Aggregate account names can now contain the 
hyphen (-) character in the same way that local 
account names can. 

16326 Aggregator The maximum number of servers is limited to 50. 

16717 Aggregator Adding a Remote Server by Aggregate View > 
Administration > Remote server administration > 
Add a Remote Server no longer results in a "Server 
Error" even though the remote server appears to 
be successfully added. 

16517 AIX The AIX scanner now properly detects the graphic 
card manufacturer and the network card MAC 
address. 

16396 Alarm Viewer The Alarms Viewer > Edit > Copy command now 
copies everything, including the date. 

15619 Alarms Viewer In the Value column of the exception called 
"Read/Write is Enabled in Serial Number entry in 
MIB,” there is no longer HTML code visible. 

16266 Alarms Viewer Selecting a report alarm in the Alarms Viewer now 
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Number Location Fix Description 

updates the recent device list. 

16798 Analysis Workbench The Analysis Workbench no longer crashes when 
Access Violation occurs. 

13680, 16344, 16351 Apache The Web-based UI is no longer unresponsive when 
many users were using it concurrently. 

16208 Applets Communications lamps are no longer blocked by 
modal dialogs. 

16223 Applets Applet Ports window can now sort by device icon. 

16748 Applets Now the SNMP credentials are displayed when you 
right-click on a device and select SNMP ping. 

16447 Backup/Restore MySQL accounts are now backed up properly. 

15239 Client Installation When installing the client distribution, there are 
no longer conflicting warnings about minimum 
RAM requirements. 

16310 Data Deletion Delete Data > Above plus accounts now deletes the 
default accounts and re-creates them. 

16562. Data Deletion When data is deleted using the Administration > 
Data Management > Delete Data:  "Network data 
and user accounts" option, all the user accounts 
are deleted. The default accounts are then 
recreated when the system restarts. 

16503 Data Import/Export The correct wording appears in the message for the 
case when no data has been selected for import.  

16528 Data Import/Export If a csv file sets some fields to "true", importing it 
again no longer changes the "true" field to "false" 
every other time. 

16844 Database MySQL warnings no longer appear in the Windows 
Event log. 

16890 Database A new mysql account can now connect to the 
aggregate database. When the system is restarted, 
the read privileges for the user-defined mysql 
accounts are no longer lost. 

16635 Device Manager A warning message has been added to the Device 
Manager > Diagnosis Panel in the Network 
Configuration section if a property is overwritten 
by a global discovery configuration option. 

16674 Diagnosis/Agent Ping The agent ping diagnostics tool will now work even 
if a Scanner Property group is not configured for 
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Number Location Fix Description 

the device. 

16848 Discovery Engine Scan-only models now have the device information 
stored into the database when the model is 
created. This also solves the issue of duplicate 
scan-only models being created sometimes. 

16636 Documentation The steps about how to configure the Enterprise 
Discovery server to have a large scan only IP range 
are now documented. 

16703 Documentation Data generated by scanners is now up-to-date. For 
example, the Mac OS X agent information is no 
longer missing and legacy platforms are included, 
etc. 

16817 Documentation The reference to Connect-It version 3.5 in the 
Installation and Initial Setup Guide has been 
corrected to version 3.6. 

16027 Environment Variables Environmental poller related options are now 
dependent on the Alarms license. 

16858 Event Browser In some cases, the device icon, name, or port did 
not appear in the Event Browser.  

16209 Events Browser There are no longer empty event records in the 
Events Browser. 

16643 Exceptions The exception for “Agent Deployment Failed" now 
filters based on the device type list configured in 
Administration > System Configuration > Agent 
Communication > Agent deployment device type 

16050 Find Previously, if you had a large network, and you did 
a search for a relatively vague value using Easy 
Find, the database would crash (and recover) if you 
had thousands of matches. 

The database no longer crashes when Find returns 
many matches. 

16526 Find The Find dialog is now non-modal. 

16430, 16431 Home Page Last failed login information no longer appears on 
the homepage if no failed login attempts have 
occurred. 

16797 HPUX The installed application detection problem on HP-
UX systems no longer occurs. 

16040, 16213, 16269, 
16270, 16272, 16273, 
16275, 16276, 16277, 

Licenses User interface elements including menu items, 
buttons, table rows and columns, tabs, and online 
help links appear only when the pertinent license 
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Number Location Fix Description 

16322, 16325, 16359, 
16735, 16790, 16014, 
16215, 16039, 16040, 
16043, 16268, 16271, 
16274, 16698 

combination is present. 

16190 MIB Browser In the MIB Browser, a continuous search for a non-
existing device no longer causes an intermittent 
"system error" pop-up. 

16739 MIB Browser The Get Next button is now enabled in the MIB 
Browser. 

16777 MIB Browser Tree in MIB Browser no longer fails to expand the 
second time that the MIB Browser is opened. 

16782 MIB Browser MIB Browser table now sorts properly on the 
Entry column. 

16783 MIB Browser The icon that allows you to go up one level in MIB 
Browser is now enabled correctly. 

16805 MIB Browser MIB Browser can now set an SNMP value with a 
quotation mark in it. 

16811 MIB Browser In the MIB Browser, Refresh now updates the 
Variable tab. 

16812 MIB Browser The set button in MIB Browser is now enabled 
when the variable is writeable. 

16525 Network Configuration IPv4 ranges can now be added using Router 
Discovery. 

16063 Network Map Map scale text entry now reverts when it loses 
focus. 

16224 Network Map Device popup information on the map is no longer 
empty when the device name is very long. 

16207 

 

Port Manager The potential server error when making a 
connection for a newly modeled device no longer 
occurs. 

16423 Port Manager The port number is now pre-selected when the Port 
Manager is called from the Device Manager and 
Port Manage window is already open. 

16220 Reports Filtering unknown file types is now consistent. 

16508 Reports The Copy Count now agrees with 
UnrecognizedFilesByScanner (summary) and 
FileReport (detail). 
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Number Location Fix Description 

16565 Reports An inconsistency in the “Top Application” reports 
has been corrected. 

16339  SAI Editor The error on attempt to open the “Import Data 
from MSI” second time has been removed  

16702 SAI Editor Potential data corruption in the Master SAI has 
been fixed. 

16810 SAI Editor Linear release relationships are no longer 
recognized as circular. 

16819 Sample Scan Files The HP-UX sample scan file has been updated. 

16815 Scan Data Viewer User list in Scan Data Viewer is now flushed when 
a new device is selected. 

16787 Scanner The scanner is configured to delete invalid 
characters. Handling of invalid characters in file 
names has been improved. 

16237 Scanner Deployment Error messages in the scanner deployment log are 
now more explicit. 

16673 Scanner Deployment If the scanner binary has been manually deleted 
from a machine, the “Run Scanner” step in the 
scanner deployment workflow will redeploy it. 

14746 Scanners The UNIX® scanners now normalize hwSCxxx 
Yes/No to 0 and 1 depending on platform and how 
these values are supported on the platform. 

16262 Scanners Device driver file attribute is now detected by the 
Win32 scanner. 

16512 Scanners Rated CPU speed is no longer written to the 
scanfile if unavailable. 

16515 Scanners The -excl:96 option now disables installed 
application detection. 

16527 Scanner deployment Scanner Upgrade step is now run if the scanner 
binary name configuration has changed. 

16610 Scanners Specific stored files are no longer stored when the 
option is disabled. 

16612 Scanners SMBIOS are no longer collected by the Linux 
scanner when it is disabled in Scanner Generator. 

16613 Scanners Swap file data is collected only if a corresponding 
option is checked in Scanner Generator. 
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Number Location Fix Description 

16614 Scanners TCP/IP (and related) settings are not detected 
when TCP/IP checkbox is unchecked in Scanner 
Generator. 

16615 Scanners PCI data is detected only if the corresponding 
checkbox is checked in Scanner Generator. 

16621 Scanners The wrong data type was used when passing file 
size as an argument. Total scanned size is now 
calculated in MegaBytes. 

16623 Scanners Various issues related to disk size calculations 
have been corrected. 

16639 Scanners cfgCreationMethod no longer shows as a Solaris 
Scanner in scan files produced by the AIX scanner. 

16640 Scanners Video Data information is no longer missing in the 
AIX scan file. 

16642 Scanners hwNetworkLogonName is now detected properly 
for HP-UX. 

16695 Scanners The scanner for the Enterprise Discovery server is 
automatically deployed even when the Deployment 
license is not present or when the "Automatic 
scanner deployment active" configuration option is 
turned off. 

16712 Scanners Scanner no longer crashes when scanning a ZIP 
archive that is located inside a .gz file. 

16715 Scanners Saving scan files on the Enterprise Discovery 
server using http no longer fails with Windows 
scanners. 

16733 Scanners BIOS detection in Linux is fixed and also can 
handle 64-bit Linux. 

16830 Scanners Cache parameter detection is fixed. 

16835 Scanners Negative one values (-1) are no longer present in 
scan files when the character should be blank. 

16627, 16632 Scanners Wildcard matching now works properly in UNIX. 

16474 Server In the case of the scanner upload, the algorithm 
limiting the data transfer based on the bandwidth 
setting has been corrected. 

16638 Server The “I want to use Enterprise Discovery as I used 
Desktop Inventory” upgrade scenario now works 
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Number Location Fix Description 

with the Topology license as well. 

16619 Solaris CPU Mask and CPU Board are now detected on 
Solaris systems. 

16624 Solaris The Solaris scanner no longer ignores auto-
mounted directories and disk size calculation is 
fixed.  

16625 Solaris The Solaris scanner can now detect many UNIX 
System Configuration Data. 

16626 Solaris User profiles are no longer missing in the Solaris 
scan file. 

16085 Solaris Scanner On Solaris 9 systems the scanner now returns the 
correct CPU count. 

16441 Solaris Scanner On Solaris 8 systems, the scanner would crash 
when using a configuration set to filter storing 
empty directories. The issue has been resolved. 

16479 Solaris Scanner Solaris 2.6 is no longer missing information from 
its Bus Data. 

16740 Solaris Scanners NIC recognition problem has been resolved on 
Solaris systems. 

16293 Status > Percent 
recognized files 

When there are no files to recognize, the graphs 
will no longer display values at 100%. 

16348 Status > Percent 
recognized files 

Trying to display the graphs when there is no data 
for a particular OS will no longer cause a server 
error. 

16341 System Monitor When the system time is moved forward, the 
System Monitor will restart. In previous releases, 
it stopped all the services but did not restart. 

16448 System Monitor Event filters are now deleted as part of the 
Administration > Data Management > Delete Data:  
"Network data, user accounts and configuration 
data" option. If the Administration > Data 
Management > Delete Data:  "Network data" 
option is used, event filters are not deleted. 

16225 Viewer The description field at the bottom of the Scan 
Data Viewer is now properly updated when 
deselecting an item from the table on the hardware 
tab. 

16564 Viewer Missing descriptions for some hardware asset 
fields in the Scan Data Viewer were added. 
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Number Location Fix Description 

16781 Viewer The viewer no longer crashes when opening a scan 
file with unknown locales. 

16201 Web Asset Questionnaire When the Web Asset Questionnaire rejects 
duplication in the User Defined Asset field, it 
explicitly indicates why. 

16298 Web Asset Questionnaire Web Asset Questionnaire can now change to a new 
device. 

16306 Web Asset Questionnaire Duplicate items are removed from the selection list 
string since strings longer than 255 characters will 
be truncated. 

16439 Web Asset Questionnaire Demo users can no longer access the Web Asset 
Questionnaire. 

16726 Web Asset Questionnaire Validation for numerical answer rules has been 
added. 

16291, 16205 Web Asset Questionnaire The radio-button values are now displayed 
properly when reset to the default. 

16205 Web UI If you select the custom value radio button, but do 
not actually change the default setting, Enterprise 
Discovery will now recognize the change. 

16236 Web UI The Enterprise Discovery tree and the right pane 
now match. 

16532 Web UI The Device Manager and Network Map now 
display all device data properly when the “Web and 
applets access” account property is changed from 
“No” to “Yes.” 

16536 Web UI If an export link does not have an HTML page, the 
item is no longer highlighted on the tree, as in 
Status > Device Status > CSV device list. 

16545 Web UI Currently logged in users no longer auto-refresh. 

16683 Web UI It is no longer necessary to restart Apache (or the 
Enterprise Discovery UI) when the active license 
changes. 

16756, 16757, 16761, 
16775 

Web UI Breadcrumb navigation has been improved and 
standardized across the user interface. 

16221 Windows The 32-bit device driver and Win16 helper exe are 
no longer run on Win64 to avoid error messages in 
the Windows Event Log. 
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Number Location Fix Description 

16226 XML Enricher New version of auto.zsai has been migrated. 

16264 XML Enricher When migrating from Network Discovery, an XML 
Enricher setting no longer has a different default. 

16376  XML Enricher An issue related to the Scan Data Viewer not being 
able to access the scan file (after the scan file 
grouping configuration has been removed) has 
been fixed. 

16544 XML Enricher The XML Enricher now outputs all applications, 
not just the ones with Main files. 

16608 XML Enricher The XML Enricher will reject scan files with no 
Asset Tag information. 
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Known Problems, Limitations, and Workarounds 

Agents 

• The agent upgrade process on Solaris 9 may take a long time (SCR# 16663).  

• MAC OS X agent upgrade may not work when initial agent was installed and run from shell (SCR# 
16828).  

Scanners 

• In Manual Deployment mode, the UNIX scanner will not save offsite scan files to a Microsoft® FTP 
server when the user name is specified in the form domainname/username (SCR# 12893). 

• The scanners cannot open some files in non-English operating systems (SCR# 16462).  

• Some files excluded in .override.ini are still being scanned (SCR# 15766).  

• In the Scan Command Line /O Switch, the “/O” should be “/o” (lower case) (SCR# 15852).  

• Automounts are being scanned in HP-UX and Linux systems (SCR# 15950).  

• Pressing Ctrl-C sometimes causes access violations for the Win32 scanner (SCR# 16780)  

• The Solaris scanner does not collect Physical Disk Data for Solaris 8 systems (SCR# 16796).  

• Cache associativity on Solaris is reported as 'unknown' (SCR# 16831)  

• The Linux scanner takes a long time to process the installed packages section of the hardware scan 
(SCR# 16834).  

• Time Zone not reported correctly on Linux 2.2 and 2.6 (SCR# 16836).  

• Disabling the operating system hardware test results in scanner not running (SCR# 16861). 

Analysis Workbench 

• In File > Load Options > Asset Fields > Add > Text File Extract > Options, whenever the "Treat field as 
a File Name" option is selected, the "Replace invalid characters with" field must be populated as well, 
even if the "Delete invalid characters" option is selected instead.  Otherwise, the “The file ‘Replace 
invalid characters with’ may not be empty” error dialog appears (SCR #15827): 

• For files in the root directory, the leading slash is missing from the beginning of the UNIX directory 
structure in AW (SCR# 16838).  

• Stored files export from AW failing(SCR# 16896). 

SAI Editor 

• SAI does not unload from the SAI Editor when it was externally overwritten with a different version 
(SCR# 16887) 
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Server Installation 

• Server uninstallation will report a “Fatal error” if the Favorites in the Registry contains an invalid path 
(SCR# 15303).  

• After an uninstallation, the branding registry keys are leftover (SCR# 15507).  

• When uninstalling Enterprise Discovery on a small server, the uninstaller may not be able to stop the 
database. It may take several tries to uninstall the software (SCR# 14370).  

• Enterprise Discovery with a Network Topology license should not be installed on VMWare (SCR# 16524). 

• Non-ASCII characters used in data directory path name can cause problems during the installation 
(SCR# 16520).  

• Unattended installation using MSIEXEC causes the installation to become corrupt if this is not the first 
installation on the server (SCR# 16785).  

Client Installation 

• After uninstalling the client, the menu items will still appear under the Windows Start menu (SCR# 
16437). 

Server 

• If your server has another service using port 80, the HP OpenView Discovery Apache service will not run 
properly (SCR# 14808).  

• If there is a MySQL query that takes too long, Enterprise Discovery will not function properly and you 
may need to restart System Monitor to recover (SCR# 13964).  

• An older openssl DLLs in the system PATH can affect the Enterprise Discovery Apache server and perl 
engines (SCR#16318).  

• Manually stopping the System Monitor service while it is starting up can cause it to hang (SCR# 16723).  

• Restarting the System Monitor may fail in certain situations (SCR# 16897) 

Web User Interface 

• Some web pages do not render correctly if the configuration of the Enterprise Discovery server has the 
decimal separator as any other character than "." (SCR# 14307).  

• Dates formatted on computer running in a non-English locale do not show correctly (SCR# 16841). 

Administration 

• Depending on the licenses, the "Resource/ Environment manage" property in Network Configuration 
may not have any effect (SCR# 14388). 

• In the "Account properties" page, changing the "Default Device Manager panel" or "Default Port 
Manager panel" to "Statistics" does not work (SCR# 16853). 
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Reports 

• Sometimes web pages under Reports do not completely render or print source code in Mozilla Firefox. 
Use the refresh button (SCR# 13803).  

Web Asset Questionnaire 

• A blank numeric field should be accepted if it is not a required field (SCR# 16279).  

• The UI may show non-printable characters in text fields (SCR# 16285).  

Miscellaneous 

• The "Server Management" page does not report correctly the server memory if the value is above 4GB 
(SCR# 16840). 

Applets 

• In the Folder tab of the MIB Browser the Object column does not sort properly (SCR# 16814).  

• Overwriting the OID field could sometimes kill the MIB Browser session (SCR# 16825)  

• The tree in the Scan Data Viewer will disappear when clicking on the "Go up one level in the tree 
hierarchy" button when the data for a main level folder is displayed (SCR# 16866).  

• The Event Browser will fail to display "SNMP Write by MIB OID" events if the applet is using JRE 
version 1.5.x (SCR# 16876).  

Scanner Generator 

• In Manual Deployment mode, if you move back and forth through the wizard, your selections may not 
remain. When you return to a screen, the defaults will reappear (SCR# 15238). 

Licensing 

Alarms License  

• Alarms-related items are not always hidden (SCR# 16041). 
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